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1.1

1.2

1 General

General

This documentation should facilitate the introduction to the handling of the XV100 touch panels from Eaton
Automation. In order to ensure a fast commissioning of the device it is necessary to follow the explanations
and references carefully.

The commissioning of the device, communication, PC program usage and project generation with GALILEO
and XSoft-CoDeSys-2 will be described step by step.

For the description in this documentation the following versions of GALILEO and XSoft-CoDeSys-2 were used:
= GALILEOV7.2.2
= XSoft-CoDeSys V2.3.9 SP2

The illustrated pictures and described functions can differ if newer or different versions of the programs are
used.

Furthermore for the print screens a 3.5” device (color) was used. For other device variants no changes in
functionality apply.

Document Index

Topic Document Doc. Number

[1] | Hardware manual User Manual MICRO PANEL XV-102 or MN048020042

User Manual MICRO PANEL XV-152 MN04802006Z

[2] | Windows CE System Description Windows CE MN05010007Z
Itis also part of the GALILEO help

[3] | Network System Description Networks in Brief MN05010009Z

(The index is not exclusive)

These helpful documents can be downloaded from our home page (www.eaton-automation.com),
«DOWNLOADS» section.

Device Variants

The devices of the product class XV100 are available in different variants. Please find further information on
our homepage www.eaton-automation.com or ask your local contact about possible device versions.
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2.1

2.2

2.3

2 Commissioning of the Device

Commissioning of the Device

General Remarks to Wiring

Car Cabling should be carried out with special care in order to ensure interference-free
operation.
The EMC values stated in the technical data can only be guaranteed if the
connections and cables are prepared according to the specifications stated.
The cabling must be laid separately from low-voltage cables or isolated with double
or reinforced insulation.

=> Further information, see Document [1] «Operating Instructions MICRO PANEL XV-1x2», Chapter
«Installationy.

Starting the device

Energize the device. > The device will boot.
If the device does not boot up and/or if an error message appears while starting (booting) the device, see
Document [1] «Operating Instructions MICRO PANEL XV-1x2», Chapter «Troubleshootingy).

@™ There is no runtime software for the visualization or optional PLC installed on the
device. From the respective software package e.g. visualization (GALILEO) and
optional PLC (XSoft-CoDeSys-2) you can install the runtimes on the device.

Switching off the device

De-energize the device.

The lifespan of the backlight can be increased by reducing the brightness, see
Document [2] «<MN05010007Z System Description Windows CE».
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2 Commissioning of the Device

24

Ethernet

The Ethernet interface of the device is used for engineering the visualization “GALILEQO” as also programming
the PLC with “XSoft-CoDeSys-2". To commission the communication between the device and the PC follow

the next described steps.

An IP-Address always consists out of a network and computer address. The network mask specifies which bits

belong to the network and which do not.

Algemein | Select for the device a free computer address from
IP-Einstellungen khnen automatisch zugewiesen werden, wenn das the local network. You can determine the network
Netzwerk diese Funktion unterstiitzt. Wenden Sie sich andemfalls an .
gen.melzwerkadministralor, um die geeigneten IP-Einstellungen zu address of your PC under start = Settlng >
e network and telecommunications connections >
" |P-Adresse automatisch beziehen . . .
¢ i properties = characteristics. Select out of the list
1% Folgende IP-&dresse verwenden:

|PAdesse TR T ‘I‘nternet'pr’cy)tocol (TCP/IP) and press the button
Subnetzmaske: 255 .255.256 . 0 prop erties”.
Standardgateway: . . .
€ DNS-Serveradresse automatisch beziehen
—{% Folgende DNS-Serveradressen verwenden: ———————————————
Bevorzugter DNS-Server: . . .
Altemativer DNS-Server: . . ]
Enweitert...
0K | Abbrechen |

Einstellungen der Netzwerkkarte des PCs

Example: IP-Address PC:
IP-Address:
SubNetMask:

This means:
Network-Address:
Computer-Address:

Network-Address:
Computer-Address:

- IP-Address device:
IP-Address:
SubNetMask:

Select an IP-Adresse for the device:

192.168.0.71
255.255.255.0

192.168.0
4l

192.168.0
72 (Number between 1-254 and not any already used in the
local network)

192.168.0.72
255.255.255.0

&= The usage of the same address twice can cause critical network problems.
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2441

2 Commissioning of the Device

Examining and Adjusting of the IP-Address of the Device

Power up the device.
= |fan information window appears after booting please close it.

After Windows CE has booted press the Start button and change to the menu Programs = Control Panel.

Double-click the icon “Network”.

Double-click the icon “ONBOARD1”.

XV100 Micro Panel MN04802013Z-EN—February 2013 www.eaton.com 9



2 Commissioning of the Device

A window ‘FEC Ethernet Driver’ will open.

oo =" Select the desired IP address and subnet
E mask. Use the gateway only when needed
MaKe | [ Obtain an 1P address via DHCP then push OK.

Bt [02sfp [z
Stretnat: PSS Pssp
I T O

K13

ot [BreJ[Ec

L 1254

€]

The IP address and subnet mask must be consistant to the network configuration of
the PC respectively the company network. In doubt ask your network administrator.

24.2 Wiring

Connect the device directly to the PC with an ethernet crossover cable. If you use an ethernet hub or switch us
a 1-to-1 patch cable.

243 Test the Ethernet Connection

To test the connection open the “Dos-Shell” on your PC over Start = Programs = Accessories and ping the
IP address of the device. (ping 192.168.0.72).
RI=E

2008 [Version 5.80.21951
—2800 Microsoft Corp.

Ping wird ausgefiithrt fir 192.168.08.72 mit 32 Bytes Daten:

Antwort von 192.168.08.72: Zeit=1ms TTL=128
192.168.08.72: Zeit=1ms TTL=128
192.168.08.72: 2 Zeit=1ms TTL=128

Antwort von 192.168.8.72: Bytes=32 Zeit=1ms TTL=128

Ping—Statistik fiir 192.168.0.72:

Pakete: Gesendet = 4, Empfangen = 4, Uerloren = 8 (Bxz Uerlust).
Ca. Zeitangabhen in Millisek.:

Minimum = ims, Maximum = 1ms, Mittelwert = 1ms

L:\>o

If the device does not answer then contact your network administrator.

=> Further information, see Document [1] «Operating Instructions MICRO PANEL XV-1x2», Chapter
«Installationy.
=> Further information, see Document [2] «MN05010007Z System Description Windows CE».
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3.1

3.2

3 The first PLC Program

The first PLC Program

If you would like to use the device without the internal PLC functionality then please jump over this chapter and
continue with Chapter «4 The First GALILEO project».

This chapter consists of a basic application which shows the programming with XSoft-CoDeSys-2 and the
special communication between PLC and HMI in a touch panel XV100.

PLC License Point on the Device

The PLC runtime needs additional license points on the device. The XV100 devices of the classification type
XV-1x2-...-PLC, XV-1x2-...-TVRC... and XV-1x2-...-TWRC... are delivered with 240 license points and are
intended for operation as HMI devices and as control devices (HMI-PLC).

Installation of the PLC Runtime System on the Device

The XV100 devices do not contain the PLC runtime. The PLC runtime can be transferred to the device with the
tool , TargetFirmwareWinCE". This tool can be started from the windows environment or from inside the XSoft-
CoDeSys-2 development environment (see Chapter 3.4).

Requirement:  The XSoft-CoDeSys-2 Software (CoDeSys) must be installed correctly on the PC. You can
find the current XSoft-CoDeSys-2 software on our homepage (www.eaton-automation.com)
under <DOWNLOADS - SOFTWARE -> XSoft-CoDeSys-2>. For unrestricted operation
of XSoft-CoDeSys-2 you need a license code. Please contact your sales vendor for this.

Perform the Installation from the Windows Surface:
Start the tool , TargetFirmwareWinCE_V2.4.8" on your PC through clicking:
Start 2 Programs = Eaton -2 CAA-Targets = XC-XV-Targets V2.3.9 SP2 2 Firmware = XV-1xx

After starting the setup the follow the dialog until the following window appears.
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3 The first PLC Program

i@ Setup - TargetFirmwareWinCE =100 x|
Installation Type "
Select Installation Type @

Please specify the Installation Type, then click “Next".

€ Installation to a removable drive

" Installation to a local directory

English

www. eaton-automation.com < Back I Next > I Cancel

Select the desired installation type and execute the next steps:
= FTP Installation (suggested routine):

The installation of the PLC runtime is done over FTP.

Required steps:

- Ensure that the device is connected to your PC via ethernet.

- Start the device.

- Start the FTP-server on the device by clicking Start = Programs = Communications = FTP

Server.
- Continue the setup on the PC until the following dialog window appears.
JSIsIE
Selec! components ) : @
‘Which components should be installed? C

Select the components you want to install.
Click "Next" when you are ready to continue.

[~ Operating System
€ Windows CE 5.0 Core 0S5 2.24.1(3312)
C2B E oot behaviour
[V autoexec.bat
[7 PLC Runtime System
[¥ PLCV248
7 Wweb ServerV2.4.8

Enaglish

wiw. eaton-automation.com < Back I Next > I Cancel |

- Select ,Boot behaviour’. Please note, that the operating system is not selected. For the
installation of the operating system, see Chapter 5.2.

- Click on the button “Next>".
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3 The first PLC Program

15! Setup - TargetFirmwareWinCE =101 x|

Destination "
Select destination C

Select the destination, where you want ta install the components.
=Click "Next" when you are ready to continue.

(" Intemal storage (Destination: \IntemalStoragef

" Removable drive [Destination: \StorageCard)

English

wiww. eaton-automation.com < Back I Next > I Cancel I

- Select the destination: “Internal storage” if the PLC runtime and PLC project should be stored
internally on the device. Select “Removable drive” if the PLC runtime and PLC project should be
stored on the SD-card and should also be started from the SD-card (also see Chapter 5). Click the
button ,Next>".

il
FTP Parameters "
What are the FTP parameters? C

Please specify the login information and click "Next" to continue.

IP Address:
192.168.0.74

Username:

Ianonymous

Password:
I guest

E ngﬂsh

wiw. eaton-automation. com < Back I Next > I Cancel |

- Enter the IP-address of the target device. Continue the setup procedure.
- After finishing the installation restart the device to start the PLC runtime.

XV100 Micro Panel MN04802013Z-EN—February 2013 www.eaton.com 13



3 The first PLC Program

= |nstallation to a Removable drive (for operation from SD Card (see Chapter 5):
The installation of the PLC runtime applies directly to the Removable drive (SD card) on the PC.

Required steps:
- Connect the Removable drive to your PC.
- Continue the setup routine on your PC until the following dialog appears.

iﬁl Setup - TargetFirmwareWinCE =10f x|
Select removable drive ~
Select the root directory of the removable drive C

e (C:) SGNII004C
< (D:) SGNII004D

#H #HEHE

(3 DVD-RAM—Laqurk

English

wiww. eaton-automation.com < Back l Next > I Cancel |

- Select the Removable drive root in the directory through selecting the disk (disk character).
- Continue with the setup.

]@ Setup - TargetFirmwareWinCE = |D|5|
Select components H
‘Which components should be installed? C

Select the components you want to install.
Click "Next" when you are ready to continue.

™ Operating System
" Windows CE 5.0 Core 05 2.24.1 (3312)
28 E oot behaviour
[V autoexec.bat
[¥ PLC Runtime System
[7 PLCV24.8
[ web ServervV2.4.8

Enaglish

www.eaton-automation.com < Back I Next > I Cancel I

- Select ,Boot behaviour’. Please note, that the operating system is not selected. For the
installation of the operating system, see Chapter 5.2.

- Click on the button “Next>".

- After completing the installation, put the removable drive back in the device. (The device has to have
power off).
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3 The first PLC Program

- Restart the device to start the PLC-runtime.

m  |nstallation to a local Directory:
All files of the PLC runtime will be installed to a local directory on your PC.

Required steps:
- Fully complete setup.

- Copy the whole contents of the directory “...\XV-1xx\" (you can find it in the newly created directory
on your PC) manually on the device under \InternalStorage\ or on the SD-card depending on the
boot operation type (see Chapter 5)

- Restart the device to start the PLC-runtime.

After successful installation of the PLC runtime and reboot of the device, a status display for the PLC runtime
will appear on the device (after clicking @ in the taskbar).

PLCWINCE  V2.4.8 (1384) n !u

[ e —

[0 program loaded!

If a visualization is already installed on the device and if this visualization hides the status display, you can
stop the visualization by pressing the CTRL button of the device.
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3 The first PLC Program

3.3 Programming the PLC-Programs with XSoft-CoDeSys-2

Requirement:  The XSoft-CoDeSys-2 software (CoDeSys) must be installed correctly on your PC and
started. On the device the PLC runtime must be installed correctly.

Over menu File = New, you can start a new project
Before you can start programming you have to select the device type in the Dialog window “Target Setting”.
-1olx|

File Edit Project Insert Extras Online Window Help

B8 B@edals|2R

Configuration:
-E] PUUSFY-: Data...]\ﬁsua...lﬁ Heso,..] < | »

[ [GNLINE [0V [READ
Please select the target ,XV-1xx-V2.3.9 SP2
|

LConfiguration:

Target Platform |Memoty Layout | General | Network functionality | Visualization |

Blatform: Ilntel Strong&RM LI
First parameter register (integer); Last parameter register (integer]: Beaister for retum value (integer]
E o [ = [ |

¥ Intel byte order

Defautt | oK | Cancel

In the dialog window that appears acknowledge with “OK”.

In the following dialog window you can now generate a programming unit. In the shown example the new POU
“PLC_PRG" in the programming language “ST" is generated.
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3 The first PLC Program

NewPOU x|
MName of the new POL: oK I
TypeofPOU——— Language of the POU Cancel I
= Program e}
¢~ Function Block. LD
" Function " FBD

Beturn Type:  SFC
[fooc .| & ST
" CFC

After that you can open the POU “PLC_PRG” in the register “POUs” and write a basic line of code:

hmiCounter:=hmiCounter+1;

I =] |
0001|PROGRAM PLC_PRG

0002(VAR

0003|END_VAR

| >

»

After entering “hmiCounter.=hmiCounter+1;" and pressing “Return” a dialog window for variable declaration
appears. Select the variable type “INT”and press OK.

x
Llass Name Type 0K I
[var | [hmiCounter [INT ]

Cancel
Symbol list Initial Value Address _-l
IGIobaI_Variables LI I _“ I~ CONSTANT
Comment: I” BETAIN
[~ PERSISTENT

In the declaration field the variable ,hmiCounter”is displayed.

=1
0001|PROGRAM PLC_PRG

0002[VAR

0003] hmiCounter: INT;

0004|END_VAR

0001|hmiCounter=hmiCounter+1;

ki >

Select in the menu Project = Rebuild All to compile the project. If the test program compiles error free then it
is ready to be downloaded.
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3 The first PLC Program

34

18

Installation of the PLC runtime starting out of XSoft-CoDeSys-2

The XV100 devices do not contain the PLC runtime. The PLC runtime can be transferred to the device with the
tool , TargetFirmwareWinCE" This tool can be started from the windows environment or from inside the XSoft-

CoDeSys-2 development environment (see Chapter 3.2).

Perform the Installation from the XSoft-CoDeSys-2 Development Environment:

Requirements:  The target system in target system setting is correct.

1. Change to the register ,Resources” in the object organizer window of your XSoft-CoDeSys-2 project

2. Select ,PLC Configuration*
3. Select the register ,Other parameters*
4

Start the installation of the runtime system by pressing the start button

4, XSoft-CoDeSys-2 - {(Untitled)* - [PLC Configuration] = E||5|
File Edit Project Insert Extras Online Window Help = Elzj
23E] 0|0 niSleR Bl
= FFConfguration
2 E‘BSOUIC‘ES Ga Settings  Other parametes
-] Global Variables
B[] library SysLibFile.lib 2.4.09 06:54:08: gl Update Operating System
B[ library SysLibPlcCtil b 2.4.09 06:54:08:
B2 library SysLibRte.ib 2.4.039 06:54:08: gl 3
B2 library SysLibSockets.lib 2.4.09 06:54:0)
B[] library SysLibT asks.lib 2.4.09 06:54:08: .
B2 library Util b 5.7.10 08:18:02: global val
\fﬂ Alarm configuration
m Library Manager / 2 4
~E5 Log L/
\E PLC - Browser
\‘E Sampling Trace
ﬁ Target Settings
[ Task configurati
m ask configura |?n HiE 5
~ % ‘Watch- and Recipe Manager
N ‘Workspace
Kl
2] PoUs|®E Data.. | 53] isu. 4 <« | »
[ [ONLINE [0V [READ

XV100 Micro Panel MN04802013Z-EN—February 2013 www.eaton.com




3 The first PLC Program

Select in the following dialog the desired version (min V2.4.8) of the runtime system.

Offeen 2|
Suchen in: I@XV-M:: El - &5 B3~

o

Arbeitsplatz

TargetFirmwareWinCE_!

-

[C:)
SGNI3004C
-

(D:)
SGNI3004D
-

Dateiname: ITargetFirmwareWinCE_VZ.4.8,exe Offnen I
Dateityp: I Firmware for WinCE Z| Abbrechen I

™ Schreibgeschiitzt ffnen

2

After the start of the setup (by double-click) follow the installation instructions in the dialog. For further
explanations, see Chapter 3.2.

3.5 Download of the program to the Device
Select in the menu Online = Communication Parameters and generate a new communication channel
(New...).
|
i~ Channel;
=) 'localhost’ via Tepdlp I I LI
Name | Yalue | Comment | ﬂl
New ...
Remove
Gateway ... |
x|
Name IMyPaneI 0K |
Boe Cancel |
Name I Info |

Tep/lp (Level 2 Route) 35 Tcp/lp Level 2 Router Driver

| |

Select ,TCP/IP (Level 2 Route®) from the possibilities and give the communication connection a name e.qg.
“MyPanel” and Acknowledge the dialog with OK.
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3 The first PLC Program

20

Communication Parameters

— Channel
hannel

5 localhost via Tep/lp IT cp/lp (Level 2 Route)
MyPanel

Name Value

Port 1200
Targetld 0
Motorola byteorder No

Comment
IP address or hostname

Communication Parameters

- Channel

= 'localhost via Tep/lp ITcpnp (Level 2 Route)
MyPanel

Targetld 1]
Motorola byteorder No

<

Comment

FNIF# [IP address or hostname

| B

\_H
x

LCancel

New ...

Remove

Gateway ...

da

Update

Cancel

New

Remove

Gateway ...

Update

R e

Enter in the field “Address” the IP-address of
your device (e.g. 192.168.0.72). To do this
you have to double click on “localhost” and
put in the IP-address and press the “return-
key” to end the input. Acknowledge the dialog
with OK.

Make sure that in the menu Online = Simulation Mode is deactivated (no checkmark should be set).

Afterwards you can download the program on the device via Online = Login. You can start the program with

Online = Run.

&= To have the PLC permanent on the device, you have to generate a boot project on
the device. If this is not done then the program is lost when the power is turned off.
To save a boot project on the device, make sure you are logged in (Online > Login)
and then select Online = Create boot project.

Further topics to the PLC can be found in the helpful documentation to XSoft-CoDeSys-2.
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3.6

3 The first PLC Program

Symbol-File Configuration

The communication between controller and a possible visualization is done over a symbolic address of the
variables. To be able to do that a symbol configuration has to be generated. Furthermore the through this
process generated symbol file can also be used as a variable import file for the visualization. Through the
import of the symbol file in the visualization all generated variables name (symbols) in the PLC are known to
the visualization and do not have to be entered again.

The symbol file is used as the basis of communication. The contents of the symbol file are configured in the
PLC-development platform. When compiling the symbol file is then generated and when downloading the
program to the PLC also the symbol file is downloaded.

&= Out of performance reasons it is suggested that only variables that are needed in the
visualization should be exported to the symbol file. Thus the variable field should be
structured. This can be applied as example by defining a global variable area where
the variables are separated between variables for visualization and variables that are
not used in the visualization.

Procedure:

In case you have not saved the PLC project yet, save the project via the menu File = Save as... on your PC.

Speichem I_) Projects j - i

Dateiname: IMyFirskPIcProgtam Speichemn I
Dateityp: IMXpro Projekt [ pro) | Abbrechen |

Lizenzinfa bearbeiten |

Generation of a new variable list:
= Under the project tree click on the register “Resources”.

- The resource-project tree will open.
= |n the resource-project tree open the directory “Resource/Global Variables”.
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3 The first PLC Program

“«

= Click with the right mouse button the entry ,Global Variables* and select ,Add Object...”.
=lolx|

QFiIe Edit Project Insert Extras Online Window Help =12 x|

22

B8 D@t DISBR » |%Em(w

2, Resources

: . Wariabler

7] library SysLib
(] library SysLib

e
[c
B[] library SysLib
e
o
B[] library Utillib

"= Data...

Rename Object, .,

1] library SysLib Edit Object
0[] library SysLib  Copy Object
Delete Gbject

Convert Object, .,
Export object, .,

Object Properties, .,

Project database

@ Alarm configu
(i Library Mana Add Action
jjj%;g Mol

i 'O_WS‘ Expand hode
% :LC Cronh?ul Collapse Node
ampling Tre
ﬁ Target Settin /2% Instance...
@ Task configu Shiow Call Tree
Q Watch-and | 550e s template, .,
3% WWorkspace

Exclude from build

Visua...

0001|PROGRAM PLC_PRG

| Adds a new object to the list on the left side.

|Lin.: 1, Col: 1

OK.
Global Variable List |
Name of the global variable list: |HM|_ValiabIes
Link to file
Filename: | Browse... I
' Import before compile " Export before compile
oK I Cancel I

Set up the symbol configuration for the symbol file:

m  Ensure that the function “Simulation Mode” in the menu “Online” is not active (no checkmark is to be

seen)

XV100 Micro Panel
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3 The first PLC Program

= (Click in the menu Project> Options... and select the category “Symbol configuration” and activate the
point “Dump symbol entries*,

- With the function “Dump symbol entries” a symbol file will be generated every time the project is
compiled.

= (Click in the menu Project> Options... and select the category “Symbol configuration” and activate the
point “Dump XML symbol table“. From GALILEO 8, this button must be activated.

- With the function “Dump XML symbol table®, a XML symbol table file will be generated every time the
project is compiled.

options x|
Category:
Load & Save

User Information

Editor
( |
Desktop [V Dump XML symbol table =

Colors
Directories
Log

Build
Passwords LConfigure symbol file ...
Source download
Symbol configuration
Database-connection
Macros

= Define from which objects the variables should be taken to export into the symbol file:
- Click on the button ,Configure symbol file...".

- In general all objects are selected. That is why you should deactivate for all objects the option
»Export variables of object".
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Set object attributes

Cancel |

¥ | Export structure componernts

v Export aray entries

XV100 Micro Panel MN04802013Z-EN—February 2013 www.eaton.com



3 The first PLC Program

- Inthe object tree open the subdirectory ,Resources \ Global Variables".

- Select the variable list that you would like to export.

- Activate the option ,Export variables of object” and confirm with OK.

51
(=] MyFirstPlcProgram. pro 0K I

B} Global Variables
i . Global_Variables

[ library SysLibFile.lib 2.4.09 07:54:08: global variables

[ library SysLibPlcCtrllib 2.4.09 07:54:08: global variables
[ library SysLibRte.lib 2.4.09 07:54:08: global variables

[ library SysLibSockets.lib 2.4.09 07:54:08: global variables
[ library SysLibT asks.lib 2.4.09 07:54:08: global variables
(] library Utillib 3.7.08 08:33:54: global variables

[V Export variables of object

v Export structure components

[V Export array entries

v Wiite access

= Confirm the project options with OK.

Allocate the needed variables for the visualization to the global variables specified for visualization:
= |n the POU-project tree double click on the programming unit in which are the variables that you would

like to allocate to the variable list.

4, XSoft-CoDeSys-2 - MyFirstPLCProgram.pro - [PLC_PRG (PRG-ST}]

QEiIe Edit Project Insert Extras Online Window Help

=10l
=18]x|

B[S E| S| S[S R ||

4 POUs

0001|PROGRAM PLC_PRG

»

— - | arding ihrans T P rArAmmelsermeine arme NAteiEnC A TarmetIEatnn Attnmatinni7 2 .
B PIJUsI'Eﬂ Data...]Vnsua.u]%ﬂeso...l | « 1 »

(

|Lin: 3, Col: 9 [ONLINE [0V [READ

m  Put the cursor in the variable that you would like to allocate.

XV100 Micro Panel MN04802013Z-EN—February 2013 www.eaton.com
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x
Class Name Type
VAR_GLOBAL % IhmiCounter |INT __I
xﬁg_&UBFL’H'T 21 Initial Value Address ﬂl

= —l I [~ CONSTANT
Comment: I RETAIN

Click in the menu Edit = Auto Declare...
- The window “Declare Variable” will open.
Select the class,Class”,VAR_GLOBAL",

I~ PERSISTENT

x
Class Name Type -UK
[var_GLoeal =] [hmiCounter [INT [ -

Cancel
Symbol list Initial Value Address 4'

Select under “Symbol list’ the variables list you would like to allocate to.

=] [~ CONSTANT

Global Variables
[~ RETAIN
[~ PERSISTENT

Confirm the adjustments with OK.

Compile and download the PLC project to the device:

Click in the menu Project> Rebuild all to compile the project.

Click in the menu Online 2 Login to log into the device.

Click in the menu Online 2 Run to start the PLC project on the device.

Click in the menu Online = Create boot project to save the project on the device.
Click in the menu Online 2 Logout to log off of the device.

&= The performance of visualization (Refresh cycle) can be increased by grouping the

individual SPS variables in data structures ,Struct” or data fields ,array“. The data
structures and data fields are transferred in a communication package between the
XSoft-CoDeSys-2 runtime system and GALILEO runtime system, individual variables
are sent in individual packages behind each other.

Further topics to PLC you may find in the helpful XSoft-CoDeSys-2 documentation.
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28

The first GALILEO Project

It consists of a simple application which should show the projecting of the connection of the HMI to the PLC of
the touch panel XV100.

Requirements:  The GALILEO visualization software must be installed correctly. You can find the current
GALILEO software on our homepage (www.eaton-automation.com) under <DOWNLOADS
- SOFTWARE -> GALILEO>. The XV100 devices are supported from GALILEO version
V7.0.3 onward. For unrestricted operation of GALILEO you need a license code. Please
contact your sales vendor for this.

Generate new Project

Start the GALILEO software. The first step is to generate a new HMI project.

Menu Project 2 New.

In the now appearing window “New Project” you should first create a new project directory.
Example : MyFirst

This is used to generate a hierarchical overview when have more than one project.

il - =X
:| Project | Edit View Draw Objects Config Extras Buld Window Help

8D New sugrat b B9 o B 002 &) Y ]

BB N Project 2Ix|LE =] «2
7 Suchen in: I@ Samples LI & ﬁ( B~

) Alphakeyb [2)UserManagementDemo
) Custom () videoDemo

0emo ‘ , .
Soemo_xv100 V\ With this button a new
) dummy

S)EnhGraph — directory is generated.
nhGrapl

3332?!!? Enter the name.
) Parameterliste
| )Rezept 2 x
) SmallDemo

|2) SmallDemoMono
- ) SprachDemo
) Teimaske

) Timer

(D)
SGN3S004D

Dateiname: I Create I .
Dateityp: IGalileo Project (*.pri) ﬂ Cancel I .

Hereupon the folder must be opened. Following this you should enter in the input field the desired file name.

| Creat
L

Example : MyFirst
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4.2

Select Device

4 The first GALILEO Project

The window “Panel Selection” is opened automatically when a new project is generated. It can also be opened
via the menu Config = Panel Type and at a later time edited.

Click “Panel Selection” and select the device type:

Filter: I [
[=-PC | Display Size: I SN
GALILEO OPEN Resolution: [320x240
=%
B 1xx PortraitfLandscape: [V
[=)- color Number of Colors: I 65536
[=-10x
«4-102-B0-35TQR Monochrome: ]
XY-102-B2-35TQR Operating System: I Windows CE
®Y-102-83-35TQR Interfaces:
X¥-102-B4-35TQR CAN
X¥-102-B5-35TQR Ethernet
Xv-102-B6-35TQR Local
X¥-102-B8-35TQR System Port

X¥-102-DO-S7TVR
X¥-102-DO-70TWR
X¥-102-D4-S7TVR
XY-102-D4-70TWR
XV-102-D6-S7TVR
X¥-102-D6-70TWR
X¥-102-D8-S7TVR
XY-102-D8-70TWR

#-11x
[+-15x
[#- monochrom

OK I Cancel

Confirm the adjustments with OK.

—Panel Type

The project is compatible for Following panels:

X¥-102-B5-35TQR-10

~Colors Operating System
[essas - windows CE 5.0 ~|
~Resolution Format

%-Resolution: I 320

Y-Resolution: | 240

¢ Landscape
" Portrait

OK Cancel

XV100 Micro Panel MNO04802013Z-EN—February 2013 www.eaton.com

For the selection field “Format’ the

option  Landscape

is

chosen

whereby the device will be used in

horizontal operation.
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4 The first GALILEO Project

4.3

30

Select PLC

The window “Select PLC” will also be opened automatically when a new project is generated. It can be opened
over the menu Config > Select Communication and edited later.

Depending on the device type CAN, MPI or RS232 different communication types are available. Select under
“Add” the communication to the PLC.

The following example uses the integrated PLC as controller type. Also more than one controller can be
selected. So that one PLC can be connected over MPI (Onboard) and another one to the internal PLC over
XSoft-CoDeSys-2. To keep in mind is the different types of addressing the variables.

Select PLC

Fim / Model | Info | PLC Data |

[~ Communication

No. Port Board Type | Model Description Selection Of the integrated PLC
0 Ethemnet CoDeSys XSoft-CoDeSys-2.. :
XSoft-CoDeSys-2
Add | Remove Modify Meta Data
Status Refresh [s]: 10
break[ms]: 0
Startup Delay[s]: 0
IP Address or Hostname: localhost

0K I Cancel Help

With OK the new project is configured.
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4.4

4 The first GALILEO Project

Generate Mask

The first step is to generate an empty mask (picture). Register card Masks, Masks (standard) > select right
mouse button ,New*":

L

¢ Project Edit View Draw Objects Config Extras Bulld Window Help

== )

Yl o8 0-0 8| # S » Y| Languagen

AN\DOO® # | @ | =(du|fizk |l @l @E@ds|:

Give the mask a name e.g.: ,Startmask”.

M 3 21T 5 ] e EET IR IR The mask can be given specific properties like
G B % & et [ e screen saver, colour, type, etc. These can be
= configured under the sub menu “Mask Settings”
New Strg+R
Sistali P bl Following this you can insert objects into the
: mask using the Objects Toolbar. Please use the
dlson - help-menu to inform yourself about the single
save As objects and their capability.
@ | Save All Masks
¢ ooes

Zehnertastatur)

Mask Settings
Project Masks
Print

Print Setup

Search Replace.
Find

| .= x
: Project Edit View Draw Objects Config Extras Build Window Help
= r | ¥ Ca@@ 9 o~ & e ) [ %% S8 b Q| Language 00 >
AN D@0 ¢ | [|=ldxu ik nl | @doe @@ OHEE
SR e e s I R A \— Objects
Masks 2% ] startmask.msk x v Toolbar
(O Fs 87 &p (24 [P wr

<Filter>

=+ Masks (standard)
[T Startmask.msk
| Masks (keyboard)

| Masks (printer report)

| Masks {sub)

Find Results a x
(=] Compiler Messages |4 Find Results
= [ 44
| »

Ready

XV100 Micro Panel
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4 The first GALILEO Project

GALILEO help system with detailed examples and instructions to every object.

As an example you can find under: <Content / Demos / Fast Start> an animated guideline for your first
GALILEO project.
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4.5

Generate Variable Structure

4 The first GALILEO Project

In our small example we are displaying a numeral value of the PLC. For this we must first generate the used
variables. This is accomplished over the register card Tags.

o1

Mot B0 Vew Oaw  Olects Confiy Eabras  BUM Wydow  Meb

JNIE S » LB @ 0-03 &8 Y owen
A\NCDQOOH U a4 fGm st w 305

[ R 2 QA e toow -

Toge 3 X 1 Startmaskmak

If the integrated PLC is used and the symbol file
of the PLC was compiled right the variables
names can be imported.

30 @l ]

- S | $Tep | i o i iPe,

tew Tog

w wor  MNewAray

Change to the register card ,Tags‘; move the
mouse cursor to any variable type e.g. “bit” and
press the right mouse button. A dialog will open
where you have to select “Import*.

freverties
« »

Fedt
0 Fird Raste

Pecrmiae akvee

) Conioher Messopns A
Frctimenn axerss >
;)
2 such pro
Tngert KIN|

gt tag

Select the symbol file of the PLC
program as the Import file. You can
find the symbol file in the same
directory where the PLC program
is saved on the PC. Confirm the
dialog with pressing the “Start’
button. Also see Chapter 3.6.

|

¢ Project Edt View Draw Objects Config E

ale =4 1 IR Y - )

# x

Fod Resds

Tag Import ﬂll
—PLC Selection
Select PLC for tag address:

- |
—Import File

IC:\, :ﬁ,MyFirstPIcProgram.SYl‘j I

—Import in Structure

I Import all tags in this structure:

Name of structure:

Start I Cancel

HANDOO®#E| [

Plp 2 ol il & %G
Tags & x ] start
O (=1 & [ [ @
<Filter>

x bit

W hmiCounter
dw dword
f float
e eror
ab string
st struct
sy system

I
Find Results
=] Compiler Me;

= | 34

jm—

Ready

Through the import of the PLC variable ,hmiCounter”from Type
WORD the variable is inserted into the tag list. The green
marking of the variable shows that a addressing to the PLC has
already occurred.
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4 The first GALILEO Project

To use variables from another controller type or to use variables without using the import function you have to
use the following procedure:

34

ICi] - =X

 Project Edit View Draw Objects Config Extras Build Window Help

g @ EE@ S @Y 8 0-0 A S > Y| Languageo

E.g. a byte variable:

= AND O ¢ @ | @ | =d2| [z @6 Position the mouse cursor on the variable
P12 S 5l ote & T % G Gh w0o% [ B L& &8 type “byte” and press the right mouse
‘:gh 2 818 e B 2 X ||l mStartmaskcmsk - button and select “New Tag’. Then enter
A — the variable name. Thus the variable is
x b generated but marked blue. The colour

o VIR owrag blue means that the variable has no
o address and thus has no possible
il communication to as PLC. This is how
st struct you generate a local visualization
i variable. With a double click on the
ff variable a Tag Settings window to the

Properties

Find tag i 2
Find/replace address d Results

Findfmove address

XV100 Micro Panel MN04802013Z-EN—February 2013 www.eaton.com

variable will open.

33 search o Strg+F
»
¢ Generate a ne IR H
A == In the Tag Settings dialog under the
: Project Edit View Draw Objects Config Extras Buld Window Help . “ A d d » | k n
HAEEES B9 B 0-0 0 EE ) B e : register card "Ad ress” you can click o
Jel= ANOOOO s | 0 =4 ERm-—new 3@ s 0= the Address “..." button and enter the
ST et T T R B o o address of the PLC. This address
Tax ax -artmask.msl| X W
e e e [ depends on the type of PLC selected. If
Lo you are communicating to the internal
L. PLC you must also enter the name of the
C L Crrrr— symbol file. (This only applies to global
; Format Address | Linits | Units Translation | PLC Varlables-)
ab
d i
@:;, b R }OnDamand\ Atssaeriup | Poling [s] }On‘gma } .aui?mfll\’/ssm‘\)fddmss
beytel [byte O J
Please use the context menus
(press right mouse button) of
the different grid areas.
oK | Apply Canicel | Help
Ready



|

© Project Edit View Draw Objects Config Extras Buld Window Help

4 The first GALILEO Project

When communicating to another
controller the address has to be entered
specific to the protocol. In the dialog
“Setting address” you can see and
select the possible nomenclature
needed. According to the desired
nomenclature the following input fields
for addressing the variables are
possible.

et Qe | 1oo-Settings x|
| \ \ Format Address |Limts | Units Translation |
H | T 5ol [T e gy T
S iy Name. | Type [SA]o| M Setting address 2UXIbe] mjs | address|
O =5 %1 & bByte1 byte ] =]
<Filter >
X bit
El-by byte
by beytel
B w word
dw dword
f float
@ eror
ab string
st struct
sy system
Clear Address concel [ k|
YA
ok | sy | cancel Hep |
Ready e
Il Setting address 21x|
| DB%%d.DBB%d ~|
The address
DB |12 |0..4095
DBB [144 | 0..65534
DB12.DBB144
Clear Address Cancel | OK I
VA

-

: Project Edit Yiew Draw Objects Config Extras Build Window Help

The displayed example shows the address of a variable
for a S7 controller over MPI. The nomenclature of a
variable is selected out of the data block of the controller.

is herewith select as DB12 byte 144.

= _>sl
e |mi] AN\ Format Address |Lims | Units Translation |
= u —_— | Read | wiite | Siemens - MPL: |
Tags e |Oon Demand| At Startup | Paling [s]  |On Demand |Enable|  M/S Address |
O (=% & byte X X fast X X Master DB].2.DBBl44I"_
<Filter =
X bit
El-by byte
by bBytel
- w word
dw dword Please use the context menus
f float (press right mouse button) of
bbbl the different grid areas.
ab string
st struct
[-sy system
4 [»
OK I Apply Cancel | Help l
=
Ready a

After following the address the variable in the variables list is marked green (=addressed).

XV100 Micro Panel
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4 The first GALILEO Project

4.6 Generate Display Object
Insert an object of the type “Value Entry / Display” in the start mask:

To do this you have to click in the object list on ,E and then draw via mouse and pressed mouse button the
object in the desired size and position on the Startmask.

. i E—
: Project Edit View Draw Objects Config Extras Buld Window Help
B EHdd % B9 > 8 @-0 2| S p Y| Languageoo %

ik ANDOOoE @ = dafEZhsa @ 3E0 @ 0EE
Iéélmﬁj;.{”“é%%%% i 1UU°/o'|;:.:':‘;|1[

T — S i Startmask.msk* =
Ol =Z: 818 (22 (5 e
<Filter =

D

by byte

B w word

~~dw dword

“o f float

e error

~~ab string

st struct

[-sy system

Through a double click on the new generated object field the property window appears. Select from the Tag list
the desired variable and confirm the dialog with OK.

x
General | Size / Pastion | Visibiity | Color/Font |
Tag: Iw hmiCounter EI !l I~ Delay
Address: - x bt I~ | Double Click
by byte

= w word
i SRUR FiCounter

e e 32767
Keyboard: @ error I 32767
-ab string

iest struct I 0
Bl-sy system
TOWEr T I

0K Apply | Cancel | Help |
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4 The first GALILEO Project

L |

: Project Edit View Draw Objects Config Extras Build Window Help

Pagd sdd b B9 > & 0-0 3| S p Y| Languageoo z

e ANDO@ ¢ | 0| =dufzfh==ukw 3@ @ 0O1EEw

Pl S0 W o 3 Elleee & Th U Gh Gy flitoow =M B L & &

Tags o 2% ] startmask.msk* x| v
O (54981 0 (24 L e

<Filter=

~ox bit -88888
by byte

- w word
~dw dword
i f Float
@ error
~-ab string
st struct
sy system

Value Entry / Display object with linked variable. (-88888)

We have finished our small project and now want to go to the next step of the project; compiling and
downloading to the device.

Compile Project

Via the menu Build = Compile or over the button ] the project will be compiled. The compiling procedure

is protocolled in a display window. Eventual errors will be displayed red. Through scrolling the detailed error
message can then be read.

'm L~ i

© Project Edit View Draw Objects Config Extras Build Window Help

i@ Cdd b B9 & 0-0 3| # 8 p Y Langugeoo -

sl ANEee ¢ #E | 0| =¥ fHm=k @ @de @ OQEEw

Pl STl e & Tl Gh jtooe = | % & & &

Tags . L2 ] startmask.msk  x v

O =981 i (24 L e

| <Fiker>
X B -88828
by byte

w word
dw dword =
f float
e error Compiler Messages a2 x
ab string | = Compiler Messages | 4 Find Results
st struct —

[#-sy system Level 3 v | DB | 5K 48

compiled 0 number of tag definitions of parameter list
wiiting the definition of central commands...

compiled O number of tag definitions of central command list
witing printer files ..

Check Fonts

witing language files ..

writing the file ‘autoexec.bat'...

witing bitmaps...

Number of graph samples : 0
Used RAM memory for araphs : 0 bytes

This Project uses 3'522'829 bytes of me
CCESSFLL FINISHED It

! Ready
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4 The first GALILEO Project

4.8

38

Simulate Project on the PC

Via menu Build = Start Project Inspector or over the button b you can start the simulation of the project on
your PC.

vl GP1000 - MYFIRST.PR] x|

| 0 PC Simulation of the project (Project Inspector)
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4.9

491

4 The first GALILEO Project

Download Project to the Device

Now the generated project should be downloaded to and started on the device.

Start FTP-Server on the Device
To get a connection between the PC and the device you must start the FTP server on the device.

Select on the device: Start = Programs = Communication = FTP Server

The FTP server is now started and
ready.

The FTP server can also be started automatically when the device is booted. To
change the Window CE start up behavior please look in the GALILEO help “Micro
Panels with Windows CE Topics”.

=> Further information, see Document [2] «MN05010007Z System Description Windows CE».
=> Further information, see Document [3] «MN05010009Z System Description Networks in Brief ».
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4 The first GALILEO Project

4.9.2

40

Setup FTP Path in GALILEO

To be able to download the project to the device the parameters for the project transfer to the device
must be generated. Change to the download dialog via the menu Build = Download (local, FTP) or

over the button —&J

ProjectPath;  [cil In the window “Download” click on the
s v | Sl button “FTP path”. The window “FTP
I Clear before download TP Path ] Connections” will appear.

r Recipe Data —

|~ Password Data Memory

™ Source project as zip

™ Components
Close

New Connection I
Edit I
Delete I
Copy |

Click on “New Connection”. The window
“Properties : FTP-Connection” will appear.

Properties: FTP-Connections ﬂz]

Title : MyPanel

Server / IP-Addiess:  |192168.0.74
User Name : Ianonymous

Use Password : I

Path : |\I nternalStorage

Browse I
| 0K I Cancel I

Enter a title, the IP-address of the device and the path for the download to the device. With a click on “Browse”
You should already find the path of the \InternalStorage of the device. But for this an active connection and the
P-address of the device must exist. Alternatively you can switch to the directory \StorageCard (SD card) (see

Chapter 5)
Click on “OK” to save the new parameters.
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4 The first GALILEO Project

The connection with its title should now be selectable. Click on the desired connection and confirm with

“Close”.

Edit |
Delete |
Copy |

Cose | field “Local/FTP path”.

Project Path:

A\

Local/FTP Path:

I o Browse

IFTP: MyPanel j Local Path I

[~ Clear before download
I Recipe Data

[~ Password Data Memory I

[~ Source project as zip bownload

[~ Components M
Close I

XV100 Micro Panel MN04802013Z-EN—February 2013 www.eaton.com
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4 The first GALILEO Project

493 Download of a Project

After the visualization project has been generated and compiled and the target settings have been completed
you can now start the project download to the device. For this select the menu Build = Download (local , FTP)

or press the button —&J .

The Download dialog appears.

Project Path: | i Browse
Local{FTP Path: IFTP: MyPanel j Local Path

[~ Recipe Data
[~ Password Data Memory
[~ Source project as zip

ETP Path

[~ Components Download

Close

L

Start the project download over the button “Download”. During the project transfer you can see the progress.

Eventual you will be asked if you want to also download updates of the operating system or visualization
runtime (GRS) over dialogs.

Transfering project

fInternalStoragefapplffonts/Tahoma.ttf
25%

If the project transfer is completed the following dialog will be displayed. Select now “Start GRS” (GRS =
GALILEO Runtime System) to start the visualization project on the device.

WiGaieo x|

Project 'myfirst’ transfered to /IntemalStorage/ |

Do you want to reboot the HMI panel or restart the Runtime GRS?

HMI reboot I Cancel |
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4 The first GALILEO Project

While the GRS starts status information will be displayed. Following that your designed mask will be displayed.

Display of the start mask from the project MyFirst. When the PLC program is started on the device the value
must be constantly changing.

If there is no connection to the PLC then a cyclic error message will be displayed with the information which
variables are without communication.
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5 Operation from the Internal Flash or SD-Card

5.1

44

Operation from the Internal Flash or SD-Card

XV100 devices which are equipped with an optional SD-card can optionally operate from internal flash as also
from SD-card.

Operation from the SD-card:

m  The OS that is stored on the SD-card is loaded

= The runtime for HMI and PLC are started from the SD-card
= The HMI and PLC project is stored on the SD-card

Switch between Booting from the Internal Flash or SD-Card
Turn on the power of the device. If an info-window appears after booting, close it.

As soon as Windows CE has booted press the Start button and change to the menu Programs - Control
Panel.

File View | (2]l
Y
BootDevice, DateTime Desplay InputPanel
@ % e i
Keyboard License Network Owner
® 5 ¢ -
Stor. ... System Touch b4
[#stat [[Tc [FEo e (@)
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5.2

5 Operation from the Internal Flash or SD-Card

Double-click the icon ,BootDevice”.

A
< Lo TN =)
StorageMa...  System Touch v

#stat [ e oo [Erat e )

You can select from the following settings:

Boot from: InternalStorage

Herewith the device boots from the device internal stored OS.
=>» Further information, see Document [2] «kMN05010007Z System Description Windows CE», Chapter
«Startup behavior».

Boot from: StorageCard

Herewith the device boots from the SD-card stored OS.
=>» Further information, see Document [2] «kMN05010007Z System Description Windows CE», Chapter
«Startup behaviory.

Version Change of the Operating System

The operating system of the XV100 is stored on the internal flash memory in delivery condition. The usage of
newer function can require a version change of the operating system. In general this is done through the
programming software GALILEO or XSoft-CoDeSys-2. GALILEO (from version V7.2.0 onward) checks while
downloading a project the operating system version and offers over a dialog a download of a different version
of operating system.

Older version of the software such as (Version of GALILEO previous to V7.2.0 or MXpro versions) must
not be used for an operating-system download. Exceptions are XV102 3.50 devices.

=> For a manual change of the operating system, see Document [2] «kMN05010007Z System Description
Windows CE», Chapter «Startup behavior».
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File Update via SD-Card (Autolaunch)

XV100 devices (OS Version V2.24.0 and upwards) can run an update automatically via an SD card. The SD
card must be configured to this end.

In the case of an update-from-file the following functions can be fulfilled:

= Update of the Windows CE OS Version

= |nstallation or update of the GALILEO and XSoft-CoDeSys-2 runtime software.
= Project installation or update of visualization and SPS projects.

= |nstallation and update of any files

The device recognizes the insertion of an SD card and executes the configuration actions. In order to configure
the update, the file AutoLaunch.inf is used. This file also enables configuration of whether the actions should
be executed on insertion of the SD card or only on starting the device. For file-update or copying of the files a
separate .BAT file is started. In this .BAT file the command-line instructions for the desired actions can be
defined.

=> Further information, see Document [2] «MN05010007Z System Description Windows CE»:
m  Chapter« AutoLaunch»
®  Chapter «Extended Copy (ExtCopy)»

We wish you lots of success and fun with your XV100.
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